
Messages Sorting, Priorities, Sig, ...
Sorting Messages Within Mailboxes
.i.Sorting;It is possible to sort the message summaries in a mailbox window according to their 
status, priority, sender, date, or subject.    These commands are listed in the Sort sub-menu under 
the Edit menu.
 
 

                                                                                              The Sort sub-menu

To use any of these commands, first open the mailbox to be sorted.    Then, select the appropriate 
command from the Sort sub-menu.    The mailbox’s messages are sorted when the mouse button 
is released.



Eudora sorts in ascending order; the smallest item first. To sort in descending order, hold down 
the [option] key while choosing the desired command from the Sort sub-menu.

Tip:
Eudora’s sorting algorithm is “stable.”    This means that sorting on a particular column leaves 
items of the same value in the same order as they were before the sort.    This feature allows you 
to sort based on multiple criteria by using .i.Sorting:Multiple criteria;multiple sort commands.    
For example, if you want your messages sorted by subject, and within each subject you want 
messages sorted by date, first choose Sort by Date, then Sort by Subject.

Note:
.i.Sorting:By date;Sometimes Eudora does not sort by date properly.    This happens if the 
mail was stored under an old version of Eudora, and the table of contents was rebuilt, or the 
messages have incorrectly formatted date fields or unknown or incorrect time zones.

------------------------------------------------------------------------------------------------------

Saving A Message to a File
.i.Messages:Saving to files;Eudora allows you to save a current message(s) to a separate text file 
on your Macintosh system.    To do this, first display the desired message or highlight its 
summary in the mailbox window.    Then, select .i.Save As... command;Save As... from the File 
menu.    The Save As dialog is displayed allowing you to choose a name and location for the file. 

 

                                                                                          The Save As dialog



Note the two options at the bottom of the dialog.    .i.Guess Paragraphs option;Guess Paragraphs 
instructs Eudora to remove extraneous carriage returns from the message, leaving returns only at 
the ends of paragraphs.    In addition, it converts multiple spaces into .i.Tabs:And Save As... 
command;tabs. 

.i.Include Headers option;Include Headers instructs Eudora to retain the message’s header 
information in the saved document.    If this is unchecked, only the body of the message is saved. 

 
Once you’ve made your choices, click on the Save button in the dialog.      
 
 

                                                                  Saving a message to a text file

If you select multiple messages from a mailbox window and select Save As..., all of the messages
are saved to a single file.
 
 



                Using “Save As...” to save several messages to one file

.i.Messages:Incoming:Recombining split messages;Tip:
When Eudora receives a very large message from the POP server, it splits that message into 
multiple smaller messages. If you need to reassemble the original message, use the Save 
As... command.

Choosing an Application for Saved Messages
.i.Save As... command:TEXT Files Belong To;When you save a message to a file using the Save 
As... command, the new text file is formatted as basic ASCII text in a Macintosh document.      
The document type is determined by the program you select using the .i.TEXT files belong to 
setting;TEXT files belong to setting in the Settings dialog (Attachments).    

To do this, select Settings... from the Special menu.    The Settings dialog is displayed.    Then, 
select the Attachments settings.
 
 

                                              The Settings dialog Attachments settings

Near the bottom of the dialog, click the TEXT files belong to button.    A standard file dialog is 
displayed.    Using this dialog, search through your disk to locate the desired application 
(probably your favorite word processing program).    Select the application and then click Open.



 
 

        Selecting an application to open the files Save As... creates

The selected application is then displayed in the Settings dialog.
 
 

                                                The desired application is now selected

------------------------------------------------------------------------------------------------------

Resending Rejected Messages 
.i.Bounced mail;.i.Rejected Mail;.i.Message:Incoming:Sending again;.i.Errors:Bounced 



mail;Mail Transport Agents are computer programs responsible for routing E-mail messages 
through networks.    If for some reason an E-mail message can’t be delivered to an intended 
recipient, these programs return the message to the original sender.    A message is typically 
rejected because of an error in the recipient’s address, although many other reasons are possible.

The message sent back from the mail system usually includes cryptic information that may allow
you to determine the reason for the message being rejected.    It also includes the text of the 
original message.    
 
 

                                                                                      A rejected message

Eudora deletes the error messages and added text and recovers the original message so that you 
can make any corrections and resend it.    To do this for the current message, select .i.Send Again 
command;Send Again from the Message menu.    This eliminates the inserted extra text and 
reformats the message as it originally appeared.      You can then make changes or additions and 
resend the message, if desired.
 
 



                                                                  A rejected message, restored

------------------------------------------------------------------------------------------------------

Message Priorities
.i.Message:Priority;.i.Priority;Eudora allows you to assign priorities to your messages.    These 
priorities are for sender/recipient reference purposes only, and they do not affect the way Eudora 
handles the messages. 

There are five priority levels available, each represented by a small icon.    Priorities range from 1
(highest) to 5 (lowest).    Priority 3 is assumed for messages that have no assigned priorities, and 
it is not displayed.

 

                                                                                                            Highest priority
 

                                                                                                                High priority

                                                                                                                            (blank)

                                                                                                                           Normal

 

                                                                                                             Low priority 
 

                                                                                                            



Lowest priority

Message priorities are displayed in the Status/Priority column of the mailbox window.
 
 

                            Message priorities displayed in the mailbox window

To change the priority of a message, open the message and choose the desired priority from the 
Priority popup menu on the icon bar.    The selected priority icon is then displayed in the popup 
window.
 
 



                                                                  Assigning a priority to a message

You can also change the priority of the current message(s) by holding down the [command] key 
and pressing a number key from 1 to 5 (1 = Highest, 5 = Lowest).

When you receive mail with a priority other than Normal, Eudora adds an .i.X-Priority field;X-
Priority: header to the mail.    The header lists the assigned priority.
 
 

                  An incoming message with a pre-assigned priority

.i.Priority:And Reply;Note:
All new messages are created with Normal priority, even replies to messages whose priority 
you have changed.    The exception to this is that, if the sender of a message gives it a 
priority other than normal, Eudora insists on giving your reply the same priority.    You can, 
however, change the priority of your response by re-assigning it manually.

------------------------------------------------------------------------------------------------------

Editing Message Subjects
.i.Message Summary:Changing subject of;.i.Subject:Changing;Sometimes the subject of a 
message is not clear or descriptive.    Eudora allows you to edit the subject of any incoming 



message.

Note:
After the are sent, the subjects of outgoing messages (messages sent by you) cannot be 
edited.    However, prior to being sent, outgoing message subjects can be changed by editing
the Subject: field in the message header.

To edit the subject of an incoming message, open it from its mailbox window.    Notice that the 
subject is displayed below the title bar and above the message proper.    You may edit this text as 
you would any other text.    When editing is complete, press .i.Enter key;Enter or close the 
message.    The new subject is displayed in the message summary.    The contents of the Subject: 
field of the message header remain unchanged.
 
 

                                            Editing the subject of an incoming message

 



                                                                                      After Editing the subject

Note:
If you reply to the message, the original subject is used for the reply, not your changed 
subject.    This gives you the freedom to put information useful to you into the summary, 
without fear of your private notes being revealed to your correspondents.

------------------------------------------------------------------------------------------------------

Printing
Eudora can print a current message or messages, a plain text window, or the contents of the Ph 
window.    To print from within Eudora, select .i.Print... command;Print... from the File menu 
with the message or item displayed.    If you have text selected in any of the above windows, you 
can print just the selected text using the .i.Print Selection... command;Print Selection... command
under the File menu.

Eudora automatically prints headers and footers on each page, giving the window title, page 
number and your return address.

------------------------------------------------------------------------------------------------------

Using the Ph Window
Eudora can access two different directory services, .i.Ph;Ph and .i.Finger;Finger, via the Ph 
window.    To display the Ph window, select Ph from the Special menu.
 
 



                                                                                              The Ph window

The Ph window has two buttons (one for Ph and one for Finger), and two text fields (one where 
you type your query, and one where you see the response).

Using Ph
.i.Ph:Using Ph window for;To use the Ph protocol, the name of a Ph server must be entered in the
Ph Server field in the Settings dialog (Hosts).    To use Ph, type the name of the person you want 
to look up in the query field and click on the .i.Ph button;Ph button.    The server’s response is 
displayed in the response field.
 
 

                                                                                A Ph query and its response

Note:
You can type any Ph command in the query field, except login commands or commands 
requiring login.    For more information about the Ph server source code, see Appendix A.

Using Finger
.i.Finger:Using Ph window for;To use the Finger protocol, type your query into the query field.    
This query should be in the form “name@domain.”    If you omit the “@domain” segment, 
Eudora assumes you mean your SMTP server host.    Once the name is entered, click on 
the .i.Finger button;Finger button.

The finger query is sent to the host specified in the “@domain” part, and the response is 
displayed in the response field.
 



 

                                                                    A Finger query and its response

------------------------------------------------------------------------------------------------------

Creating a Signature
A “.i.Signature;signature” is a brief message automatically added by Eudora to the end of 
outgoing messages.    It should consist of a few lines giving the sender’s full name and E-mail 
address.    Other pertinent details, such as phone number, postal address, or place of employment 
are also sometimes included.

To create the signature, select .i.Signature:Menu command;Signature from the Special menu.    A 
blank Signature window is displayed.    Type your signature text in this window.
 
 

                                                                                                              Typing a signature

When you are finished typing the signature, close the Signature window.    An alert is displayed 



asking if you want to save the changes to your signature.    Click Save.    You may modify your 
signature at any time by repeating this procedure.

In order to activate your signature on an outgoing message, click on the signature icon on the 
icon bar.    
 
 

                                                  Activating your signature in the icon bar

The signature text is not displayed at the end of messages you create, but your recipients see it.
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